
Chapter 3

Starting a New Project

After completing this chapter, you will be able to:
• Create project templates
• Understand and create grids
• Understand and create levels
• Understand and create work planes 
• Sketch reference planes
• Create scope box

Learning Objectives

• Create scope box
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In the previous chapter, you learned how to open a new fi le and create initial setups. Now, 
after opening a new fi le and creating some initial setup such as units and snaps, you need 
to learn about creating advanced setups such as creating the project templates, levels, and 
grids for your project. These advance setups help you to start your project more effi ciently 
and accurately.       

In this chapter, you will learn how to create a project template, save the project template and 
then learn to create structural grids and levels for a structural project. Further, you will learn 
the use of Work Planes and Reference Planes in your project.  

PROJECT TEMPLATE
Project templates are fi les that can be opened while starting a new project. These fi les, 
commonly known as template fi les, contain predefi ned settings for projects, display of 
annotations, display of graphics, and so on. For projects, these fi les contain predefi ned settings 
for project units, rebars, and structural elements. Similarly, for the display of graphics, the 
template fi les contain predefi ned settings for materials, line styles, line weights, line patterns, 
and structural symbols. 

Project templates provide initial conditions for a project. In Revit Structure, you will fi nd 
in-built templates that are saved with .rte as fi le extension when you install the software. You 
can also create your own template based on the project requirement. In Revit Structure, any 
new template-based project inherits all families, settings (such as units, fi ll patterns, line styles, 
line weights, and view scales), and geometry from the template. 

Template fi les carry project-specifi c information. You may have different project template fi les 
for different types of projects. For example, for a concrete structure, you may not use steel 
members for your design purpose. For these types of project, you may require a template that 
carries families with more concrete sections and less steel members. A template fi le can also 
carry predefi ned levels and grids and thus saves a lot of time while starting up a new project. 
Schedules for footings, columns, piers, and other structural elements can also be a part of a 
project template.  

The use of template fi le is quite extensive and a right approach toward reducing the cycle 
time of a project. In the next sections, you will learn how to create custom templates and use 
them in a structural project.

  Creating a Custom Project Template
In Autodesk Revit Structure, there are various methods to create a custom project template. 
The common method is to open an existing template fi le and modify its settings based on 
the project requirement and then save it as a different template fi le. You can also create a 
custom project template by starting a blank project fi le, defi ning all settings such as naming 
the viewports, creating levels, adding grids, and others, and then saving it as a template (.rte) 
fi le. For certain projects, you can create a template fi le which includes geometry that can be 
used repeatedly as a base for the new projects. For example, if you have defi ned geometry for 
a shopping complex and want to include this geometry whenever you start a new project, you 
can save the fi le that includes this geometry as a template. Each time you open a project with 
this template, the geometry is included.
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 Creating a New Template from a Blank Project File

In Revit Structure, you can create a new template fi le from a blank project fi le or use the 
default template fi le (Structural Analysis-Default.rte). To create a template fi le from a blank 
project fi le, choose New > Project from the Application Menu; the New Project dialog box 
will be displayed. In the Template fi le area of this dialog box, select the None option from 
the drop-down list. Next, select the Project template radio button in the Create New area and 
choose the OK button; the Undefi ned System of Measurement dialog box will be displayed, 
as shown in Figure 3-1. This dialog box prompts you to select a system of measurement for 
your project. 

You can choose the Imperial or Metric option from this dialog box. If you select the Imperial 
option, a template fi le containing all default unit settings in Imperial unit system will open. 
Similarly, if you select the Metric option, the template fi le containing default units in the 
Metric system will open. After opening the template fi le, you can modify its existing settings 
based on your project environment and then save the modifi ed fi le as a template fi le. To do 
so, choose Save As > Template from the Application Menu; the Save As dialog box will be 
displayed. In this dialog box, select a folder from the Save in drop-down list and enter a name 
for the template fi le in the File name edit box. Note that the Template Files (*.rte) option is 
selected from the File of type drop-down list. After entering the fi le name, choose the Save 
button; the template fi le will be saved with the settings defi ned in the blank project fi le.

Note
You can also select the default template fi le, Structural Analysis-Default.rte, to create a new 
template fi le from a blank project. To do so, select the Structural Template option from the 
Template fi le area of the New Project dialog box, and then choose the OK button.     

 

Figure 3-1  The Undefi ned System of Measurement 
dialog box

Tip: You can change the default template fi le displayed in the New Project dialog box. To 
do so, invoke the Options dialog box by choosing the Options button from the Application 
Menu. Next, in the Project template fi le area, click in the Path column corresponding 
to the Structural Template name; a browse button will be displayed. Choose the browse 
button; the Browse For Template File dialog box will be invoked. In this dialog box, select 
the fi le that you want to make the default template fi le and then choose the Open button.  

Application Menu:  New > Project
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Creating a New Project Template from an Existing Project Template
To speed up your project, you may be required to use predefi ned template fi les. These 
template fi les contain predefi ned information or settings pertaining to the project you need 
to start. To use these template fi les, choose New > Project from the Application Menu; the 
New Project dialog box will be displayed. In this dialog box, ensure that the Project template 
radio button in the Create new area is selected. Now, to select the desired template fi le for 
your project, choose the Browse button; the Choose Template dialog box will be displayed, 
as shown in Figure 3-2. In this dialog box, browse to the desired folder to locate the template 
fi le. Next, select the template fi le from the folder and choose the Open button; the Choose 
Template File dialog box will close and the New Project dialog box will be displayed again. 
In this dialog box, keep the default setting and choose the OK button; a new project fi le will 
open, which inherits all project settings from the selected template fi le.

Settings for the Project Template
While creating a project template, you can predefi ne certain settings based on your project 
requirement. To start a new project template, you need to fi ll in the information specifi c to the 
project. The information includes the name of the project, project number, client’s name, and 
so on. These information are useful while publishing or plotting the drawing. Next, you need 
to enter the project settings. These settings include units, snaps, the line styles for components 
and lines, fi ll patterns for materials, and more. Some of the settings such as units and snaps 
have already been discussed in Chapter 2. 

After modifying the project settings, you can create settings for families. The families in a 
project template can be system families and loaded families. While defi ning the settings for 
the project template, you can modify or duplicate system families (for example, walls) as 
required for the project. You can also load the commonly used families, user-defi ned families, 
and title blocks. 

Figure 3-2  The  Choose Template dialog box
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After setting families in the project template, you can modify or create settings for project 
views. These settings include plan views (Structural Plans), levels, schedules, sheets, and so on. 
There are other settings that can be made for the project template other than those discussed. 
These are visibility/graphics settings, and the plot (Print) settings. The settings for the project 
information are discussed in the next section.

Setting the  Project Information
When you create a project template, you can also set the project information. To do so, 
choose the Project Information tool from the Settings panel of the Manage tab; the Project  
Properties dialog box will be displayed, as shown in Figure 3-3. In this dialog box, you can 

specify various settings related to the project information displayed in the Instance Parameters 
area. To enter information regarding the Organization Name, Organization Description, 
Building Name, and Author of the project, click on the value fi elds of their corresponding 
parameters and enter appropriate values in them. Similarly, to edit the energy setting of 
the project, choose the Edit button in the Value fi eld of the Energy Settings parameter; 
the Energy Settings dialog box will be displayed. In this dialog box, you can specify various 
settings related to the type of the building, site location of the building, and the level that will 
represent the ground plane of the site. To do so, click on the Value fi elds corresponding to 
the Building Type, Location, and Ground Plane parameters and specify the desired values 
in them. To enter information regarding start date or issue date of the project, click on the 
Value fi eld of the Project Issue Date parameter and enter a valid date. Similarly, to specify 
the status of the project, click on the Value fi eld of the Project Status parameter and specify 
a valid status of the project.

To enter the address of the location of the project, choose the Edit button in the Value fi eld 
of the Project Address; the Edit Text dialog box will be displayed. In the text area of this 
dialog box, enter a suitable address and choose the OK button; the address of the project 
will be updated. Next, specify the name and number of the project in the Value fi elds of the 

Figure 3-3  The  Project Properties dialog box for setting the project 
information
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Project Name and Project Number parameters, respectively. After entering the appropriate 
information in the Project Properties dialog box, choose the OK button; the Project Properties 
dialog box will close and the project information entered will be updated. 

In addition to the parameters discussed in the Project Properties dialog box, you can add more 
parameters for entering project information. To do so, choose the Project Parameters tool from 
the Settings panel of the Manage tab; the Project Parameters dialog box will be displayed. 
Choose the Add button from this dialog box; the Parameter Properties dialog box will be 
displayed, as shown Figure 3-4. Ensure that the Project parameter radio button is selected in 
the Parameter Type area of this dialog box. Next, select the Project Information check box 
from the Categories area. In the Parameter Data area, enter the name of the parameter data 
in the Name edit box. For example, you can specify Engineer’s Name as the name of the 
parameter. Next, you need to assign a discipline for the new parameter. To do so, select an 
appropriate option from the Discipline drop-down list. For example, to assign a discipline for 
the Engineer’s Name parameter, ensure that the Common option is selected in the Discipline 
drop-down list. To assign type and group for the Engineer’s Name parameter, select the Text 
and Other options from the Type of Parameter and Group parameter under drop-down lists. 
Next, choose the OK button; the Project Parameters dialog box will be displayed with the 
added parameter displayed in the list box. Choose the OK button from this dialog box; the 

newly created project parameter will be added in the Project Properties dialog box. Figure 3-5 
shows the partial view of the Project Properties dialog box for the project information with 
Engineer’s Name as the added parameter.

Figure 3-4  The  Parameter Properties dialog box
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Setting the  Project Location
For every project in Revit Structure, you need to defi ne a location with respect to a coordinate 
system.  This defi nition includes the geographical location (azimuth) of a project, which needs 
the latitude and longitude of the nearest city and the coordinate system of the host model and 
the linked model (if present).

To defi ne the geographical location of a project, choose the Location tool from the Project 
Location panel of the Manage tab; the Location Weather and Site dialog box will be displayed, 
as shown in Figure 3-6. This dialog box contains two tabs: Location and Site. The Location 
tab is chosen by default. In the Defi ne Location by drop-down list of this tab, the Internet 
Mapping Service option is selected by default. As a result, you can use the Google map service 
to fi nd out the geographical location of a desired place. To fi nd out the geographical location, 
type it in the Project Address edit box and then choose the Search button; the location searched 
will be displayed in a map. Alternatively, you can select the Default City List option from 

Figure 3-5  The partial view of the Project Properties dialog box displaying 
the newly added parameter
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the Defi ne Location by drop-down list. This option is selected to specify a city nearest to the 
project location and to defi ne the latitude and longitude of the location. To specify the nearest 
city, select an option from the City drop-down list; the Latitude and Longitude edit boxes 
will display the corresponding values for the latitude and longitude of the selected city. If the 
name of a city is not available in the City drop-down list, then enter the values of it latitude 
and longitude in the Latitude and Longitude edit boxes, respectively. You can choose the Site 
tab in the Location Weather and Site dialog box to name the current setting of the location. 
The options in the Site tab are shown in Figure 3-7. In this tab, the name(s) of location(s) is 
(are) displayed in the Sites defi ned in this project list box. By default, the Internal (current) 
location is listed and selected in the list box. To defi ne a different location for the project, 

Figure 3-6  The options in the Location tab of the 
Location Weather and Site dialog box

Figure 3-7  The  options in the Site tab of the Location Weather 
and Site dialog box
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choose the Duplicate button from the Location Weather and Site dialog box; the Name 
dialog box will be displayed. Enter a name in the Name edit box and choose the OK button; 
the Name dialog box will be closed and the name of the new location will be listed in the 
Locations defi ned in this project list box. After you have added a location, you will notice that 
the Delete and Make Current buttons are active. You can choose the Delete button to delete 
location(s) apart from the current location. A current location is a location being currently 
used. To make a location current, select the location from the Sites defi ned in this project list 
box and choose the Make Current button. Note that after you have made a location current, 
the name of the location is suffi xed with the word (current).

 Transferring Project Standards

When you create a template fi le, you can copy project standards from 
another project to the current fi le. These standards include various 

project settings such as Family Types (only system families, not loaded families), Line Weight, 
Line Styles, Line Patterns, Materials, View Templates, and so on. To transfer project standards 
to the template fi le (target fi le), open the source fi le from which standards are to be copied. 
Next, choose the Transfer Project Standards tool from the Settings panel of the Manage tab; 
the Select Items To Copy dialog box will be displayed, as shown in Figure 3-8. 

In the Select Items To Copy dialog box, click on the down arrow in the Copy from drop-down 
list; the list of opened projects will be displayed in the drop-down list. Next, select any of the 
projects from which you want to copy standards. Note that when you select a source project 
from this list, the standards included in the project along with their respective check boxes 
are displayed. By default, all check boxes in the list box are selected. You can keep the check 
boxes selected for the standards you want to copy to the template fi le and clear rest of them. 
If you want to clear all check boxes for fresh selection, you can choose the Check None button 

Ribbon:  Manage > Settings > Transfer Project Standards

Figure 3-8  The  Select Items To Copy dialog box
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located on the right of the list box. Similarly, to select all check boxes, you can choose the 
Check All button. After selecting the check boxes for the standards that you want to transfer, 
choose the OK button; the Select Items To Copy dialog box will be closed. Note that if the 
selected standards are already present in the template fi le, the Duplicate Types message box 
will appear, as shown in Figure 3-9. You can choose the Overwrite button from this message box 
to overwrite the common standards or choose the New Only button to transfer the standards 
that are present in the template fi le. After you have chosen the required options, the selected 
standards will be copied to the destination fi le.

Setting the  Browser Organization
While creating a project template, you can organize the Project Browser. To do so, 
choose the Browser Organization tool from the Windows panel; the Browser Organization 
dialog box will be displayed, as shown in Figure 3-10. This dialog box contains two tabs: Views 
and Sheets. The Views tab is chosen by default. The options in this tab are used to select, 
edit, or create a browser organization for the views present in the project. In the list box of 
the Views tab, the list of default browser organizations is displayed with their respective check 
boxes. By default, the check box for all browser organization is selected. You can edit the 
settings of the check boxes displayed. To do so, click on the name of the browser organization 
whose setting you want to change, and then choose the Edit button; the Browser Organization 
Properties dialog box will be displayed, as shown in Figure 3-11. This dialog box contains 
two tabs: Folders and Filter. The Folders tab is chosen by default. The options in this tab 
are used to create group by sorting the project views, refer to Figure 3-11. After specifying 
the options in the Folders tab, you can choose the Filter tab to apply a fi lter to project views. 
In the Filter by area of this tab, refer to Figure 3-12, you can specify view property, the fi lter 
operator, and the fi lter value. After specifying options in the Folders and Filter tabs, choose 
the OK button from this dialog box; the Browser Organization Properties dialog box will 
close and the settings of the selected browser organization will be edited. Similarly, you can 
also create a new browser organization for the project views. To do so, ensure that the Views 
tab is chosen from the Browser Organization dialog box and then choose New from it; the 
Browser Organization Name dialog box will be displayed. In this dialog box, you can enter 
the name of the new browser organization in the Name edit box and then choose the OK 
button; the Browser Organization Properties dialog box will be displayed. The options in 
this dialog box have already been discussed.

Figure 3-9  The Duplicate Types message box
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Similar to creating browser organization for a project view, you can also create browser 
organization for sheets. To do so, choose the Sheets tab from the Browser Organization dialog 
box. The Sheets tab displays a list box containing the list of default browser organizations for 
sheets. The options in this tab are similar to those discussed for the Views tab.

Figure 3-11  The  options in the Folders tab of the Browser 
Organization Properties dialog box

Figure 3-10  The Browser Organization dialog box
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USING  LEVELS
Creating levels is one of the important tasks in a BIM project. In any structural model of a 
building project, levels defi ne horizontal planes for placing the level-hosted elements, such 
as walls, roofs, foundations, fl oors, slabs, beams, columns, and ceilings. 

In Revit Structure, you can use the Level tool to add new levels by sketching the required level 
lines in elevation or section views. By default, all level lines have associated labels that display 
the name and elevation of the level. There are two types of level that you can create: story and 
nonstory. The procedure to create these levels is discussed later in this chapter. A story level 
defi nes a fl oor, roof, or ceiling of a building. You can create a level for each known story in a 
structural model. The main characteristic of story levels is that they have corresponding plan 
views. In a project view, the level bubble for a story level will be displayed in blue.

On the other hand, a nonstory level does not hold any plan view but can act as host 
for placing objects and information. The examples of a nonstory level are top of wall, top 
of foundation, and top of slab. The level bubble for a nonstory level is displayed in black. 
Figure 3-13 shows both types of levels in the East elevation view of a structural model. In this 
fi gure, the T.O. Columns and Column Splice levels are nonstory levels and the rest of levels 
are story levels.

In Autodesk Revit Structure, when you use the default template fi le for creating a new project fi le, 
it loads two predefi ned levels: Level 1 and Level 2. These levels are displayed in the elevation 
or section view. You can view any of the elevations or section views using the Project Browser. 
Levels can be added, renamed, and modifi ed at any time during the project development. In 
the following sections, you will learn more about properties of levels, creating levels, modifying 
levels, and working with levels.

Figure 3-12  The  options in the Filter tab of the Browser 
Organization Properties dialog box
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Understanding  Controls in a Level
A typical level is represented by a level line, level bubble, level name, level elevation, and 
so on, as shown in Figure 3-14. You can modify the appearance of a level by using these 
controls and parameters. The level name is a modifi able parameter, which is used to refer 
to different levels. The level elevation is the distance of the level from the base level. The visibility 
of level bubble on either sides of the level line can be controlled by using the bubble display 
control. The length alignment control can be used to align level lines. Autodesk Revit Structure 
provides the 2D or 3D extent control for datums when you select them. As a result, you can change 
their extents in one or multiple views in which they are visible. When a datum is in the 3D mode, 
any modifi cation made in the 3D view is propagated in all views of the structural model. On the 
other hand, the 2D mode can be used to modify the datum in a specifi c view, thereby making 
it view-specifi c. In the next section, you will learn about adding levels in your project.

Figure 3-13  Different types of level in the East elevation view

Figure 3-14  Various controls of a typical level
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 Adding Levels  

In Autodesk Revit Structure, you can create multiple levels in an elevation or a section view. 
To create a level, invoke the Level tool from the Datum panel of the Structure tab, as shown 
in Figure 3-15; the Modify | Place Level tab will be displayed. In this tab, choose any of the 
sketching options displayed in the Draw panel to create levels in your project. Alternatively, 
you can invoke the Level tool by entering LL. After invoking the Level tool, you can select a 
level type from the Type Selector drop-down list in the Properties palette. There are three 
options in this drop-down list: Level: 1/4” Head, Level: Story Level, and Level: Story Level-no 
head. If you select the Level: 1/4” Head option from the drop-down list, level lines will be 
added as dashed lines along with the level bubbles. If you select the Level: Story Level option 
from the drop-down list, level lines will be added with continuous line along with the level 
bubbles. Similarly, by selecting the Level: Story Level-no head option, you can add level lines 
as continuous lines without level bubbles. 

You can choose the Line (default) or Pick Lines tool from the Draw panel of the 
Modify | Place Level tab to sketch the level line. Notice that the Make Plan View check 
box is selected in the Options Bar. This implies that when a level is added, Autodesk Revit 
Structure treats it as a story level under the Structural Plans head in Project Browser. As a 
result, the level created will be displayed under the Structural Plans head in Project Browser.
While working with the Level tool, if you clear the Make Plan View check box from Options          
Bar, a nonstory level will be created. As a result, the associated views will not be created. The 
Offset edit box in the Options Bar can be used to add a level at a specifi ed distance from the 
selected point or element. 

To add a level, invoke the Level tool and move the cursor near the existing level line. The 
temporary dimension displayed indicates the perpendicular distance between the nearest level 
and the cursor. To add a level at the specifi ed distance from the existing level line, enter the 
perpendicular distance value, as shown in Figure 3-16. Next, click to specify the fi rst point and 
move the cursor to left or right. You will notice that the level line, level name, and elevation 
appear and move with the cursor. On moving the cursor above the endpoint of the existing 
level line, a dashed alignment line appears, indicating its alignment with the existing level, 
as shown in Figure 3-17. When the alignment line appears, click to specify the endpoint of 
the level line.

Ribbon:  Structure > Datum > Level  
Shortcut Keys:  LL

Figure 3-15  Invoking the Level tool 
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Note
Although levels are infi nite horizontal planes, you are required to specify the start point and 
endpoint of level line. However, the placement of a level line can be useful in the elevation 
and section views.

The recently added level, when selected, will be highlighted and will display two square boxes, 
one each on either side of the level, as shown in Figure 3-18. These boxes are used to control 
the visibility of the level bubble. They can be checked or cleared to make the bubble visible or 
invisible, respectively, at the desired side(s). The two small circles representing the drag controls 
for the level line can be used to increase or decrease its length. The padlocks act as the length 
alignment control for the alignment of all level lines. When the padlock is locked, if you change 
the length of a level line, all level lines aligned to it will increase or decrease simultaneously. 
To modify the length of a single level line, unlock the control and then modify its length.

Instance and Type  Properties of a Level
Like other structural and building elements used in Autodesk Revit Structure project, levels also 
have associated types and instance properties. To view and modify the instance properties of 

Figure 3-16  Entering the perpendicular distance value

Figure 3-17  The appearance of a dashed alignment line along with the 
cursor
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a level, select the level from the drawing; the instance properties of the selected level will be 
displayed in the Properties palette, as shown in Figure 3-19. You can use this palette to view 
and modify the type properties of the selected level. To do so, choose the Edit Type button; 
the Type Properties dialog box will be displayed. Alternatively, you can display this dialog 
box by choosing the Type Properties tool from the Properties panel of the Modify | Levels 
contextual tab. You can use the Type Properties dialog box to modify and view the type 
properties of the level selected from the drawing. The parameters in the Properties palette 
and the Type Properties dialog box are discussed next.

Instance Properties of a Level
When you change the instance property of a selected level, the properties of the selected 
instance are changed. Different instance properties of a level are described in the 
following table: 

Parameter Name Description
Elevation Refers to the vertical height of a level from 

the elevation base.

Figure 3-19  The instance properties displayed in the Properties palette 

Figure 3-18  The selected level displaying two check boxes on its right 
and left
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Story Above Specifi es the building story above the current 

level. By default, the next highest level will be 

specifi ed for this parameter. To change the 

value of this parameter, click on the value 

field corresponding to this parameter; a 

drop-down list will be displayed. The drop-

down list will display all the levels above 

the current level. You can select any of these 

levels to specify it as the story above the 

current level.   

Computation Height Specifi es the computation height for a level. 
This value is entered to calculate the area, 
perimeter, and volume of a room.

Structural Specifi es that the current level is a structural 
level. To specify this parameter, select the 
check box displayed in the value field 
corresponding to this parameter. 

Building Story Specifies whether the current level will 
be  a building story or not. A building 
story is a fl oor level such as fi rst, second, 
third, and more. By default, the check box 
corresponding to this parameter is selected; 
As a result, the current level will become a 
building story.

Scope Box Refers to the scope box assigned to the level 

that controls its visibility in different views.

Type Properties of a Level
The type properties of a level can be viewed and modifi ed in the Type Properties dialog box, 
refer to Figure 3-20. When you change the type properties of a level, all instances of the level 
are modifi ed. In the Type Properties dialog box, you can modify the value of a parameter by 
clicking its Value fi eld and selecting a new value from the drop-down list or entering a new 
value in the fi eld. Different level type properties are described in the table given next.

Parameter Name Value and Description
Elevation Base   Describes the elevation base value with respect 

to project or the shared origin.

Line Weight Refers to the weight of a line defi ning the 

level. It can be selected from the drop-down 

list. 
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Color Refers to the color of a level line and can be 
selected from the available colors. The default 
color is black.

Line Pattern Used to set the linetype of a level line.

Symbol Refers to the symbol indicating level and 

can be selected from the drop-down list. The 

None option can be selected if the level head 

is not required.

Symbol at End 1 Default Check box is used if a bubble is required at the      
left end of a level line.

Symbol at End 2 Default Check box is used if a bubble is required at the      
right end of a level line.

Figure 3-20  The Type Properties dialog box of the selected 
level 
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Changing the Level Parameters
While working in a structural project, you may need to change various parameters of a level 
based on your project requirement. The type and instance parameters can be changed by 
using the Properties palette and the Type Properties dialog box. The options in this dialog 
box have already been discussed in the previous sections. Further, you can change the level 
type by selecting a level and then selecting a different level type from the Type Selector 
drop-down list. In Revit Structure, some of the parameters can also be modifi ed by clicking 
on the level element in the drawing window and entering a new value. For example, after 
selecting a level, you can click on its name. On doing so, an edit box will appear with the 
present name highlighted. Remove the present name, type a new name, and then click again 
or press ENTER. Note that if you are renaming the level for the fi rst time, Autodesk Revit 
Structure will prompt you to specify whether you want to rename all the corresponding views. 
If you choose to rename the views, the name of the associated views will also be changed in 
the Project Browser. Similarly, you can also modify the elevation of a level by selecting the 
elevation value below the elevation name and entering a new elevation value in the edit box, 
which will be displayed on clicking it, as shown in Figure 3-21. When you enter a new value, 
the level automatically moves to the specifi ed elevation. 

Alternatively, you can move levels by simply dragging them to the desired location. To do so, 
select a level line and drag it to the desired location. As you drag the level line, the elevation 
level changes dynamically with respect to the cursor location. It is recommended to hold 
the SHIFT key to constrain the cursor to move vertically. After dragging the level line to the 
desired location, release the mouse button; the level will be 
relocated to a new position.  

While working on a project, you may need to quickly view the 
structural plan of a level that is displayed in the elevation. 
To do so, open an elevation view and move the cursor near 
a level line until it gets highlighted. Next, right-click on the 
highlighted level line; a shortcut menu will be displayed, as 
shown in Figure 3-22. In the shortcut menu, choose the Go 
to Floor Plan option to open the corresponding fl oor plan 
for the level. 

Figure 3-21  Entering a value for the new elevation in the edit box

Tip: It is recommended that you name the building story level according to the fl oor such as 
fi rst fl oor, second fl oor, roof, and so on. This helps in referring to their corresponding plan 
views. This will also help in editing the level-hosted elements. The names assigned to the 
levels are also refl ected in the schedules created for the project.

Figure 3-22  Choosing the Go 
to Floor Plan option from the 
shortcut menu
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For certain levels, you may want to move the level bubble to a different location. On selecting 
a level, you will notice that a break control appears below its name, next to the level bubble. 
The break control can be used to break the level line and move the level bubble away from 
it. On clicking this control, you will notice that the level name and the level bubble are 
also moved to the new location and an extension line is created. Figure 3-23 illustrates the 
appearance of the bubble dots before and after they are moved. Notice that as the bubble is 
moved, it appears with two blue dots. You can use the blue dots to place the level bubble at 
the appropriate location.

Controlling the  Visibility of Levels
While working in an elevation view or a 
section view, sometimes you may need 
to hide some or all level lines to avoid 
congestion of construction lines. This 
helps in viewing the detail lines for sections 
and elevations properly. To do so, in the 
elevation view or section view, select the 
level line that you need to hide and right-
click; a shortcut menu will be displayed. 
From this shortcut menu, choose Hide in View > Elements, as shown in Figure 3-24; the 
selected level line will be hidden. If you need the hidden level line to be visible, choose the 
Reveal Hidden Elements button from the View Control Bar; the hidden level line will 
appear red in the drawing area. Next, select the level that appears in the drawing area and 
right-click; a shortcut menu will be displayed. Choose Unhide in View > Element from the 
shortcut menu. Next, choose the Close Reveal Hidden Elements button from View Control 
Bar; the hidden level will appear.

Figure 3-23  The level bubble before and after its relocation

Figure 3-24  Choosing the Elements option from 
the shortcut menu

Tip: When you select a level, its distance from the adjacent levels is displayed. Click on 
the corresponding temporary dimension and enter a new value to move the level to a new 
location.
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Similar to hiding a single level line, you can also hide all levels that are displayed in an 
elevation or a section view. To do so, select any level from the view and right-click; a shortcut 
menu will be displayed. Choose Hide in View > Category from the shortcut menu; all levels 
in the view will hide. 

GRIDS
Grids are the essential features that will help you align and place structural elements 
such as columns, beams, and walls in a structural plan. With grids, you can easily trace the 
exact location of a desired column or any other structural elements. Grids are defi nite vertical 
planes represented as lineworks in the plan, elevation, and section views.

You can add grids as lines or arcs. You can also create them from existing lines, or link or import 
them from other software such as AutoCAD Architecture, Revit Architecture, and AutoCAD 
and then convert them to revit grids. In the following sections, you will learn how to create, 
modify, and understand the grids.

Creating Grids

To create a grid, invoke the  Grid tool from the Datum panel of the Structure tab; 
the Modify | Place Grid tab will be displayed. The options in the Modify | Place 
Grid tab can be used to assign and change the element properties (instance and type) 
of the grid, to select a type for grid, and draw grid in the desired plan or elevation, 
refer to Figure 3-25.

Before you start sketching grids, you need to assign their element properties (instance or 
type) using the Properties palette. To do so, invoke the Grid tool; the Properties palette will 
display the parameters that can be added to the grid. In the palette, you will notice that the 
value assigned to the Scope Box parameter is None, which implies that no scope box will be 
assigned to the grid to be added. Next, in the palette, choose the Edit Type button; the Type 
Properties dialog box will be invoked. In this dialog box, you can change the type parameters 
of grids, as discussed next.

Type Parameters of a Grid
Before sketching a grid, you can assign its type parameters. To do so, choose the Type Properties 
tool from the Properties panel in the Modify | Place Grid tab; the Type Properties dialog 
box will displayed. Figure 3-26 shows the partial view of the dialog box. In this dialog box, 
you can change values for various type parameters, which are given in the following table:

Figure 3-25  The options in the Modify / Place Grid tab  

Ribbon:  Structure > Datum > Grid
Shortcut Key:  GR
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Parameter Name                        Value and Description

Symbol Refers to the display of symbol at the end grid.  

Center Segment Refers to the display type of the center segment of a grid line. You 
can select Continuous, None, or Custom from the drop-down 
list.

Center Segment Weight  Refers to the line weight of the center segment, if the Center 
Segment parameter is set to Custom. 

Center Segment Color  You can assign a color to the center segment, if the Center Segment 
parameter is set to Custom.

Center Segment Pattern Refers  to the l ine type of  the center segment,  i f 
the Center Segment parameter is set to Custom. You                      
can select various line types from the drop-down list.

 End Segment Weight   Refers to the line weight of a grid line, if the Center Segment 
parameter is set to Continuous. You can set the line weight of the 
end segments if the Center Segment parameter is set to None or 
Custom.

End Segment Color Refers to the color assigned to a grid line, if the Center             
Segment parameter is set to Continuous. You can set the      
color of end segments, if the Center Segment parameter is set 
to None or Custom 

Figure 3-26  Partial view of the Type Properties dialog box
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End Segment Pattern Refers to the line type of the grid line if the Center Segment 
parameter is set to Continuous. You can set the line type of the 
end segments if the Center Segment parameter is set to None 
or Custom.

End Segments Length  Refers to the length of each end segment as measured in the 
sheet, if the Center Segment parameter is set to None or 
Custom.

Plan View Symbols End 1 
(Default)

Refers to the default visibility status of  the symbol at end 1 of the  
grid line in the plan view. By default, the check box is cleared. 
If you select the check box, the visibility of the symbol at end 1 
in the plan view will be turned on.

Plan View Symbols End 2 
(Default)

Refers to the default visibility status of the symbol at end 2 of 
grid line in the plan views. By default, the check box is selected. 
If you clear the check box, the visibility of symbol at end 2 in the  
plan view will be turned off.

Non-Plan View Symbols 
(Default)

Refers to the default visibility status of the grid line in sections 
and elevations other than in the plan views. You can control 
the visibility of the symbol at the top and bottom of grid line by 
selecting various options from the drop-down list.

 
Sketching the Grids 
After assigning the type parameters in the Type Properties dialog box, you can now start 
sketching the grid line. To sketch the grid line, invoke any of the sketching tools from the 
Draw panel of the Modify | Place Grid tab. The Draw panel of the Modify | Place Grid tab 
contains four tools: Line, Start-End-Radius Arc, Center-ends Arc, and Pick Lines, as shown 
in Figure 3-27. The use of these sketching tools is discussed next.     

Sketching a Grid Using the Line Tool
The Line tool in the Draw panel of the Modify | Place Grid tab is invoked by default. 
To start sketching the grid line, click at the desired location in the drawing area to specify 
its start point. Notice that as you move the cursor, a grid line with one end fi xed at the 

Figure 3-27  The sketching tools in the Draw panel
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specifi ed point and the other end attached to the cursor is created. A temporary angular 
dimension, indicating the angle of the grid line with the horizontal axis is also displayed, 
as shown in Figure 3-28. Click to specify the endpoint of the grid line when the appropriate 
angular dimension is displayed. You can also sketch an arbitrary inclined grid line and 
then click on the angular dimension to enter a new value of the angle. To draw orthogonal 
grids, hold the SHIFT key and restrain the movement of the cursor to the horizontal and 
vertical axes. When you click to specify the endpoint, a grid is created and its controls are 

highlighted, as shown in Figure 3-29. Also, the recently added grid is highlighted and 
displays one square box on either side. These boxes are used to control the visibility of 
grid bubble. They can be selected or cleared to make the grid bubble visible or invisible 
on the desired side(s), respectively. The two circles on the start point and the endpoint 
can be dragged to extend or reduce the extent of the grid line.

Similarly, when you sketch a new grid line near an existing one, a temporary dimension 
indicating the distance between them is displayed. You can enter a value in the edit box 
to specify the distance, as shown in Figure 3-30. Alternatively, you can move the cursor 
to the desired location using the temporary dimensions and click to specify the start 

Figure 3-28  Temporary angular dimension displayed while sketching the grid

Figure 3-29  The highlighted controls of the grid created

Figure 3-30  Distance value entered in the edit box for another grid  
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point of the second grid line. Then, move the cursor horizontally to the right, and when 
the alignment line appears, click to specify the endpoint of the grid line. On doing so, 
the second grid line will be created. Notice that the name of this grid is 2. Autodesk Revit 
Structure automatically numbers the grid lines as they are created.  Similarly, you can draw 
more parallel grid lines. The Offset edit box in the Options Bar is used to specify the 
offset distance of a grid line from the desired point. To create vertical grid lines, specify 
the start point below the fi rst grid line. Next, move the cursor vertically upward and click 
below the last horizontal grid line to specify the endpoint. You can create multiple vertical 
grid lines by using the method used for creating multiple horizontal lines. 

You can also create a rectangular grid pattern that is aligned at a given angle to the 
horizontal axis. You can also specify different angles for grid lines and create grid patterns 
based on your project requirement. 

Sketching a Curve Grid
You can sketch curved or radial grid patterns based on your project requirement. To do 
so, invoke the Start-End-Radius Arc or Center-ends Arc tools from the Draw panel of 
the Modify | Place Grid tab. 

After you have invoked the Start-End-Radius Arc tool, click at a point in the drawing 
area to specify the start point of the curved grid. Next, click at an appropriate location 
to locate the endpoint of the grid. On doing so, the curved grid will emerge with the 
temporary dimension displayed for the radius. Enter a suitable value for the radius or 
click in the drawing area; the curved grid will be created. Alternatively, after invoking the 
Start-End-Radius Arc tool, you can create multiple curved grids by selecting the Radius 
check box from the Options Bar. To do so, enter a suitable value in the edit box next to 
the Radius check box and then pick the start point and endpoint in the drawing to create 
an arc. You can also use the Center-ends Arc tool to create an arcs by defi ning its center 
point, start point, and endpoint.

While sketching a structural grid, generally a combination of radial and linear grid patterns 
is used. Figure 3-31 shows a grid pattern created by using both the line and arc tools.

Creating Grids Using the Pick Lines Tool
The Pick Lines tool is useful for creating grid lines that are aligned to existing elements. 
When you choose this tool from the Draw panel of the Modify | Place Grid tab and move 
the cursor near an existing element, the cursor snaps to certain object properties such 
as the interior face of walls, centerlines of columns, and so on. Click when the desired 
property of the element is highlighted; Autodesk Revit Structure automatically creates a 
grid line along the specifi ed alignment of element. 

Tip: It is recommended that you draw grid lines with the endpoints aligned to each other. 
You can use the alignment line that is displayed when the cursor is moved to its proximity. 
The Lock constraints can be used to drag the extents of the single or multiple grid line.

Tip:  You can also use different editing tools such as Copy, Array, Mirror, Move, and so 
on to create grid patterns. Autodesk Revit Structure numbers grids intuitively. For example, 
if you create an array of a grid named A, the new grids will sequentially be named as B, 
C, D, E, and so on.  
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For example, to create grid lines for the structural wall profi le, invoke the Pick Lines tool 
from the Draw panel and move the cursor near the curved exterior wall. As you move the 
cursor over the wall, it will snap to the interior and exterior faces. Click when the interior 
face is highlighted, as shown in Figure 3-32; a grid line aligned with the interior face of 
the wall will be displayed, as shown in Figure 3-33. Similarly, you can click on the other 
wall segments to create a grid pattern required for the building.

 If the cursor does not snap to the centerline of the wall, you can align the grid lines along 
the center of the wall by specifying the distance value of the centerline from the interior 
face in the Offset edit box and then use the Pick Lines tool to select the interior face.

Creating Multi-Segmented Grids
In Autodesk Revit Structure 2013, you can create grids having more than one segment. To 
create a multi-segmented grid, choose the Grid tool from the Datum panel of the Structure 
tab; the Modify | Place Grid tab will be displayed. In the Draw panel of this tab, choose 
the Multi-Segment tool; the Modify | Edit Sketch tab will be displayed. In the Draw panel 
of the tab, the Line tool is chosen by default. As a result, the grid segment that you will 
draw will be a straight line. In the Draw panel, you can choose other sketching tools such 
as Start-End-Radius Arc, Center-ends arc, Tangent- end arc, and others depending on the 
requirement of the sketch of the grid lines in the project. In the Options Bar the Chain check 
box is selected by default. As a result, the grid will be created from end-to-end in a chain. If you 
clear this check box you need to specify start and end points for each grid segment that will be 
created. In the Options Bar, you can enter a suitable value in the Offset edit box to specify a 
offset distance by which the grid segment will be offsetted from the point you specify on the 
drawing area. In the Options Bar, the Radius check box is cleared by default, as a result no 
fi llet or curve will be created at the joins of the grid segment. On selecting the Radius check 
box, the edit box next to it will be enabled. As a result you can specify a suitable value in it to 
set the fi llet radius of the curve that will be created at the join of two grid segment. Next, after 

Figure 3-31  An example of a grid pattern created using an arc and 
straight grid lines
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specifying the desired options in the Options Bar, click in drawing area to start the multi-
segment grid line. Now, click in the drawing area to specify the endpoint of the grid line. 

Modifying Grids
Grids can be modifi ed before or after they are created. To modify a grid, you need to select 
the grid and modify its properties using the Properties palette. Some of the parameters 
can also be modifi ed by selecting the grid in the drawing window and entering the new 
values. For example, after selecting the grid, you can click on its name and assign it a new 
name. Similarly, you can modify the distance between the grids by selecting the temporary 
dimension and entering a new value. When you enter a new value, the grid automatically 
moves to the specifi ed distance.

You can also move multiple grids by simply dragging them to the desired locations. To do 
so, click and select a single grid. Then, hold the CTRL key and click to select multiple grids. 
Next, you can drag the grid(s) to the desired location. Hold the SHIFT key to restrain the 
movement of the cursor in the orthogonal direction. When you move the cursor near a grid, 
it gets highlighted. At this stage, right-click and then choose the Properties option from the 
shortcut menu to display the Properties palette, if it is not displayed in the interface of Revit 
Structure. You can also choose other options from the shortcut menu such as Select Previous, 
Select All Instances, and so on to select other grids. For certain grids, you may need to move 
or offset grid bubble to a different location. To do so, select a grid; a blue circle will appear 
on each of its endpoints. Also, the grid line break control will appear near the grid bubble. 
This control is used to create a grid bubble offset. You can click on this control and use the 
drag controls displayed to move the grid bubble to the desired location. The grid name also 
moves to the new location. Note that an extension line is created along it.

Figure 3-32  The interior face of the wall 
highlighted

Figure 3-33  Grid line created from the edge of the 
interior face of the wall
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 Customizing the Grid Display
In Revit Structure, you can customize the grid display depending upon your requirement. 
You can change the color, line weight, and line type of the entire grid line or part of the grid 
line such as center segment and end segment. You can also change the display of symbols at 
the end of the grid line.

Changing the Continuous Grid Line
A grid line is said to be continuous when the Center Segment parameter in the Type Properties 
dialog box is set to Continuous. You can change the line type, line weight, and color of the 
end segments using various options available in the Type Properties dialog box. Similarly, you 
can change the display of a symbol at the ends of a grid by using the other options available 
in the Type Properties dialog box.

Creating a Grid Line with Central Gap
You can create a grid line with central gap between its two end segments. To do so, select the 
1/4” Bubble Custom Gap or 1/4” Bubble Gap option from the Type Selector drop-down list 
in the Properties palette. Then, set the Center Segment parameter in the Type Properties 
dialog box to None. Figure 3-34 shows the display of grid line with gap between two segments. 
You can also change the display properties of the end segments, as discussed above.

Creating a Grid Line with Center Segment
You can create a grid line with the center and end segments containing different display 
properties such as line color, line weight, and line pattern. To do so, select the 1/4” Bubble 
Custom Gap or 1/4” Bubble Gap option from the Type Selector drop-down list in the 
Properties palette. Then, set the Center Segment parameter in the Type Properties dialog 
box to Custom. You can change the display properties of the center segment and end segments 
using various options available in the Type Properties dialog box.

 Controlling the Visibility of Grids
You can control the visibility of each grid or all grids in any of the project views. To do so, select 
a grid and right-click; a shortcut menu will be displayed. Choose Hide in View > Category 
from the shortcut menu; the grid category will be hidden in the current view. Similarly, you 
can also hide one particular grid by choosing Hide in View > Elements from the shortcut 
menu. On doing so, the selected grid will be hidden in the current view. However, the grid 
will be displayed in all the other views. 

Alternatively, you can control the visibility of the grids by using the visibility/graphics feature 
of Autodesk Revit Structure. To do so, select a grid from the drawing and choose the Override 
by Category tool from Modify | Grids > View > Override Graphics in View drop-down;  the 
Visibility/Graphic Overrides for Structural Plan: <view name> dialog box for the current 

Figure 3-34  Figure showing the grid line with a central gap
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project view will be displayed. In the Annotation Categories tab of this dialog box, clear the 
check box for the visibility of grids; the visibility of all grids will turn off in the current view. 
You can also control the visibility of grids using the Scope Box feature.

WORKING WITH  REFERENCE PLANES

Reference planes help sketching and adding structural elements to a design. 
They can be used as datum planes to act as guidelines to create elements. 
They can also be used for creating new family elements. To create a 

reference plane, invoke the Ref Plane tool from the Work Plane panel of the Structure tab. 
Alternatively, enter RP; the Modify | Place Reference Plane tab will be displayed. In the Draw 
panel of this tab, the Line tool is invoked by default. You can use this tool to draw a straight 
line or a chain of connected line segments to represent a reference plane. Before drawing 
a reference plane using the Line tool, you can use the Offset edit box in the Options Bar 
to specify a suitable offset distance for it. To draw a line for the reference plane, click at the 
desired location in the drawing window. Next, drag the cursor to a new location and release 
the left button to specify the endpoint of the reference line; the reference plane will be created. 
To assign it a name, select the reference plane and enter a name for it in the corresponding 
fi eld of the Name parameter in the Properties palette.

Alternatively, you can draw a reference plane in your project view by selecting the edge of a 
wall, beam, column, or an existing model line in the drawing. To do so, invoke the Ref Plane 
tool as discussed earlier and then choose the Pick Lines option from the Draw panel of the 
Modify| Place Reference Plane tab. On doing so, you will be prompted to select an edge or 
a line from the drawing. Move the cursor toward the desired edge of an element; the edge 
of the element will be highlighted. Click on the highlighted edge to add a reference plane 
aligned to it.

WORKING WITH  WORK PLANES
A work plane is a plane used to sketch elements. In Autodesk Revit Structure, you can create 
and edit only those elements that are in the current work plane. A work plane can be horizontal, 
vertical, or inclined at any specifi ed angle. Each generated view has an associated work plane. 
This plane is automatically defi ned for some standard views such as fl oor plans. For others 
such as sections, elevations, and 3D views, you can set the work plane based on the location 
of the elements to be created or edited. The concept of work planes is especially useful for 
creating elements in elevations, sections, or inclined planes. You will learn more about the 
work planes in the following sections.

Setting a Work Plane

You can set a work plane based on your project requirement. To set a work plane, invoke the 
Set tool from the Work Plane panel of the Structure tab; the Work Plane dialog box will be 

Ribbon:  Structure > Work Plane > Ref Plane 
Shortcut Keys:  RP

Ribbon:  Structure > Work Plane > Set
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displayed, as shown in Figure 3-35. This dialog box shows the current work plane and assists 
you in specifying parameters for setting a new work plane. In the Specify a new Work Plane 
area, you will notice a drop-down list available on the right of the Name radio button. This 
drop-down list contains the options that can be levels, grids, and named reference planes. 
Select an option from the drop-down list to set the current work plane.

The Pick a Plane radio button can be used to set a work plane along an existing plane. To do 
so, select this radio button and then an existing plane in the drawing. You can select the Pick 
a line and use the work plane it was sketched in radio button to create a work plane that is 
coplanar with the plane on which the selected line was created.

Controlling the Visibility of Work Planes

You can control the visibility of the current work plane by invoking the Show tool 
from the Work Plane panel of the Structure tab. The work plane appears as a grid 

in the current view. To hide it, choose the Show tool again. 

You can also set the grid spacing for a work plane. To do so, select a work plane from the  
drawing; the work plane will be highlighted. Specify the spacing by entering a new value in 
the Spacing edit box in the Options Bar. You can also enter the spacing in the corresponding 
value fi eld of the Work Plane Grid Spacing parameter in the Properties palette. You can snap 
to the work plane grid using the object snap tools. These tools can be used to create basic 
locations for columns and footings in a project view.   

Using the Workplane Viewer Window
While working in a project you may require to modify elements at a specifi ed workplane. To 
do so, you can use the Workplane Viewer window. This window displays temporary views of 
models present in the Project Environment and helps in editing the profi le in forms, sweeps, 
blends, and swept blends. You can invoke the Workplane Viewer window by choosing the 
Viewer tool from the Workplane panel of the Structure tab. 

Figure 3-35  The Work Plane dialog box

Ribbon:  Structure > Work Plane > Show
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WORKING WITH  PROJECT VIEWS
While working on a structural model, you may need to view its different exterior and interior 
portions in order to add or edit elements in the design. Autodesk Revit Structure provides 
various features and techniques that can be used to view the structural model. In this section, 
you will learn about the tools that help in working with views.

Viewing a Building Model
The  de f au l t  t empla t e  f i l e  ha s  c e r t a in 
predefined standard project views, displayed 
in the Views head of the Project Browser, 
as shown in Figure 3-36. These views include 
structural plans, 3d views, and elevations. To open 
a view, double-click on its name; the corresponding 
view will be displayed in the viewing area. In the 
Revit Structure interface, you can hide or unhide 
the Project Browser. To do so, choose the User 
Interface tool from the Windows panel of the View 
tab; a cascading menu will be displayed. By default, 
the Project Browser check box is selected in this 
cascading menu, which indicates that the Project 
Browser is displayed in your drawing. Clear this 
check box to hide the Project Browser in your 
drawing.      

Autodesk Revit Structure also enables you to add 
elements to a building model by simply dragging and 
dropping them directly from the Project Browser 
instead of using the Type Selector drop-down list.
 
When you open a new project, the viewing area displays four inward arrow symbols in the fl oor 
plan view, which indicates the four-side elevations: North, East, South, and West. You can use 
these symbols to view appropriate building elevation by double-clicking on them. 

Controlling the Visibility of Elements in Views
To control the visibility of certain categories of elements, select the element from the drawing; 
the contextual tab related to it will be displayed in the ribbon. From the View panel of the 
displayed contextual tab, choose the Override Graphics in View drop-down menu; a list of 
available override tool will be displayed. Next, select the Override by Category option from 
the list; the Visibility/Graphic Overrides dialog box for the specifi c view will be displayed. 
You can use the various tabs in this dialog box to hide different categories of elements.

SCOPE BOX

The Scope Box tool helps you controlling the visibility of the datum elements (grids, reference 
lines, and levels) in the project views. As described earlier in this chapter, these datum elements 
have infi nite scope and they extend throughout the project. Using the Scope Box tool, you 

Figure 3-36  The options displayed in 
Project Browser

Ribbon:  Structure > Create > Scope Box
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can create boundary limit for the visibility of these datum elements. You can also specify the 
views in which these datum elements become visible. 

 Creating a  Scope Box
A scope box can be created in the plan view by invoking the  Scope Box tool. You can invoke 
this tool from the Create panel of the View tab. Once this tool has been invoked, the Options 
Bar displays the Name and Height edit boxes. You can enter the name and height of the 
scope box in their respective edit boxes. To create a scope box, move the cursor in the viewing 
area; the cursor will change into a cross symbol and will prompt you to draw scope box in the 
plan view. To defi ne the scope box, click on its upper left corner, move the cursor to the lower 
right corner, and then click to specify the diagonally opposite ends. Note that the rectangle 
should be drawn in such a way that the elements that need to be visible are enclosed in it. 
The scope box with the assigned name will be created. When you select the scope box, drag 
controls are visible on it, as shown in Figure 3-37. These drag controls can be used to resize 
the scope box.

Applying a  Scope Box to Datum Elements
The visibility of datum elements can be controlled by associating them with a scope box. To 
associate the scope box created to the desired datum elements, select the scope box from the 
drawing; the properties of the selected scope box will be displayed in the Properties palette. 
Click on the value fi eld corresponding to the Scope Box parameter and select the name of the 
scope box from the drop-down list. Next, choose the Apply button to apply property to the 
selected datum element. On doing so, you will notice that the datum elements that intersect 
the boundary of the assigned scope box will restrict its extent throughout the boundary of the 
scope box. Figures 3-38 and 3-39 illustrate the extent of the grid elements before and after 
applying the scope box to them. 

Controlling the  Visibility of a Scope Box
A scope box can be resized to limit its visibility for certain views. Its visibility can also be 
controlled for each view. To do so, select a scope box, and then in the Properties palette, 

Figure 3-37  The scope box displayed in the drawing
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choose the Edit button displayed in the value fi eld for the Views Visible parameter; the 
Scope Box Views Visible dialog box will be displayed. This dialog box lists all views types 
and view names available in the project. The Automatic visibility column shows the current 
visibility of scope boxes. You can click in the Override column for a specifi c view and select 
the Visible or Invisible option from the drop-down list displayed to override the automatic 
visibility setting, refer to Figure 3-40.

TUTORIALS

In this tutorial, you will create various project settings such as project information, project location, 
and browser organization for the project created in Tutorial 1 of Chapter 2. Further, you will add 
levels and grids to the project fi le. Use the following project parameters and specifi cations:   
                                                              (Expected time: 1 hr 15 min)

1. Rename Level 1 and Level 2 as Below Grade and Entry, respectively.

2. Specify the elevation of Below Grade and Entry levels as -4’ 0” and 0’ 0”, respectively.

Figure 3-38  Grids before applying the scope 
box

Figure 3-39  Grids after applying the scope 
box

Figure 3-40  Selecting an option from the drop-down list in the Override column    

Tutorial 1                  Commercial Complex
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3. Levels to be added: Second Floor - Elevation 12’ 6”
    Roof - Elevation 25’ 0”     

4. File name to be assigned: c03_Commercial-Complex_tut1.rvt
 The following steps are required to complete this tutorial:

a. Open Tutorial 1 of Chapter 2. 
b. Set the project information, project location, and browser organization.
c. Modify existing levels and add new levels.
d. Add grid lines.   
e. Save the project using the Save As tool.
f. Close the project using the Close tool.

Opening an Existing Project 
In this section, you will open the project fi le created in Tutorial 1 of Chapter 2.

1. To open the project fi le, choose Open > Project from the Application Menu; the Open 
dialog box is displayed.

2.  In this dialog box, browse to C:/revit_structure_2013 folder and then choose the 
c02_Commercial-Complex_tut1.rvt project file. You can also download this file from 
http://www.cadcim.com. The path of the fi le is as follows: Textbooks > Civil/GIS > Revit 
Structure > Exploring Autodesk Revit Structure 2013.

3.  Choose the Open button from the Open dialog box to open the selected project fi le.
 

Setting the Project Information
In this section, you will add project information to the opened fi le. Further, you will defi ne 
a parameter for the project information and add it to the project information of the project 
fi le.    

1. To set the project information for the project, choose the Project Information tool from 
the Settings panel of the Manage tab; the Project Properties dialog box is displayed.

2.   In this dialog box, specify the project parameters as follows:

 Parameter     Value
     
 Project Issue Date    02/05/2012
 
 Project Status     Started
 
 Client Name    CADCIM Technologies
 
 Project Address    525, Andrews Drive Schererville 
 
 Project Name    Commercial Complex
 
 Project Number    CT/02/12
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3. In the Project Properties dialog box, choose the OK button; the dialog box closes and 
the project parameters are saved in the project fi le.

4. Next, you need to create an additional instance parameter for the project information. 
To do so, choose the Project Parameters tool from the Settings panel of the Manage tab; 
the Project Parameters dialog box is displayed.

5. Choose the Add button from the Project Parameters dialog box; the Parameter Properties 
dialog box is displayed.

6. In the Parameter Properties dialog box, scroll the list in the Categories area and then 
select the Project Information check box.

7.   Now, in the Parameter Data area, ensure that the Instance radio button is selected. Then, 
select the Common option from the Discipline drop-down list, if it is not selected by 
default.

8. Next, select the Text and Other options from the Type of Parameter and Group parameter 
under drop-down lists, respectively.

9. In the Parameter Data area, enter Project Engineer in the Name edit box.

10. Choose the OK button in the Parameter Properties dialog box; the Project Parameters 
dialog box is displayed, as shown in Figure 3-41. 

11. Choose the OK button; the Project Parameters dialog box is closed.

12. To enter the value for the new parameter, choose the Project Information tool from the 
Settings panel of the Manage tab; the Project Properties dialog box is displayed.

13. In this dialog box, click in the Value fi eld corresponding to the Project Engineer parameter 
and enter Sham Tickoo.

      Figure 3-41  The Project Parameters dialog box  
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14. Next, choose the OK button; the Project Properties dialog box closes and the value for 

the newly added parameter is saved in the project fi le.

Setting the Project Location
In this section, you will specify the geographical location of the project.
 
1. To specify the geographical location of the project, invoke the Location tool from the 

Project Location panel of the Manage tab; the Location Weather and Site dialog box is 
displayed.

2. In the Location Weather and Site dialog box, choose the Site tab and then the Duplicate 
button; the Name dialog box is displayed.

3. Enter CADCIM-IN in the Name edit box and then choose the OK button; the Name 
dialog box closes and the name entered is displayed and highlighted in the Sites defi ned 
in this project list box, refer to Figure 3-42 .

4. Next, choose the Location tab in the Location Weather and Site dialog box; the options in 
this tab are displayed.

5. Select the Default City List option from the Defi ne Location by drop-down list.

6. Next, select the Indianapolis, IN option from the City drop-down list.

7. Next, select the Use Daylight Savings time check box and then choose the OK button; 
the dialog box closes and the settings for the project location are saved in the project 
fi le.

Figure 3-42  CADCIM-IN selected in the Sites defi ned in 
this project list box of the Site tab
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Setting the Browser Organization
In this section, you will specify the settings for customizing the Project Browser displayed in 
the drawing area of the project.

1. To customize the Project Browser, choose the Browser Organization tool from View  
> Windows > User Interface drop-down; the Browser Organization dialog box is 
displayed.

2. Ensure that the Views tab is chosen, and then select the Discipline check box in this 
tab. 

3. Next, choose the Sheets tab in the Browser Organization dialog box; the options in this 
tab are displayed.

4. In the Checkmark indicates current browser organization list box, select the Issue Date 
check box.

5. Now to apply the modifi ed settings, choose Apply and then OK from the Browser 
Organization dialog box; the modifi ed settings are applied to the Project Browser and 
the Browser Organization dialog box is closed.

Modifying the Existing Levels
In this section, you will modify the existing levels in the project fi le. To do so, you need to 
select an elevation view from the Project Browser and then use the Level tool.

1.  Before modifying the levels, move the cursor to the Project Browser and then double-click 
on the North option displayed under the Elevation (Building Elevation) node; the current 
view is changed to the North elevation view. 

Note
In the North elevation view, make sure that the Hidden Line option is chosen for the Visual 
Style in the View Control Bar. 

2.  Next, zoom into the drawing area so that the text on the level lines is visible. Click on the 
Level 1 level line and move the cursor over the text Level 1; the text is highlighted. 

3. Click on the text; an edit box is displayed.

4.  Enter Below Grade in the edit box and press ENTER; the Revit message box is displayed. 
This message box prompts you to confi rm whether or not to rename the corresponding 
view of the selected level. 

  
5. Choose the Yes button; the name of the level changes. Also, notice that the name of the 

view corresponding to the changed level has been changed under the Structural Plans 
head in the Project Browser.
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6.  Next, move the cursor over the elevation value of the Below Grade level; the elevation 
value is highlighted.

7. Click on the highlighted elevation value; an edit box is displayed.

8. Enter -4’ 0” in the edit box and press ENTER. Next, press ESC to exit from the modifi cation 
controls.

9.  Repeat steps 2 to 8 to rename the Level 2 level to Entry and modify its elevation to 
0’0”.

10.  Next, right-click in the drawing area; a shortcut menu is displayed.
 
11.  Choose the Zoom To Fit option from the shortcut menu; the extents of the level lines are 

displayed in the drawing area.

12.  Next, select the Below Grade level line and then place the cursor over the grid length 
control displayed on the left.

13. Press the left mouse button and drag the mouse to the right; the level lines move along 
the cursor.

14. Click in the drawing area when the length of the level line reduces to half of their existing 
length.

15. Press ESC to exit from the edit controls. 

16. Next, right-click in the drawing area and then choose Zoom To Fit from the shortcut menu; 
the current view fi ts the extent of the length of level lines.

Adding New Levels
In this section, you will add new levels to the project fi le using the Level tool.

1. To add a new level, choose the Level tool from the Datum panel of the Structure tab; the 
Modify | Place Level tab is displayed.

  
2.  Move the cursor near the left endpoint of the Entry level line, and when the alignment line 

appears, type 12’6” and press ENTER in the edit box displayed, refer to Figure 3-43.

3. Next, press ENTER and move the cursor toward the right side until the alignment line 
appears above the Entry level bubble and then click to complete the level line, as shown 
in Figure 3-44. A new level line is created, displaying the level name as Level 3 and the 
elevation as 12’6”.

4. Without exiting the Level tool, repeat steps 2 and 3 to create a level line with the name 
Level 4 at a distance of 12’6” from the Level 3 level line. Note that the elevation of the 
Level 4 level line is displayed as 25’ 0”.

5.  Press ESC twice to exit from the Level tool.
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6. Select the Level 3 level line; the properties of the selected level line are displayed in the 
Properties palette.

7.  In the Properties palette, click in the value fi eld corresponding to the Name parameter 
and replace the existing name Level 3 with Second Floor.

8.  Choose the Apply button in this palette; the Revit message box is displayed.

9. In the Revit message box, choose the Yes button; the name of the level line Level 3 
changes to Second Floor. Also, notice that the name of the corresponding view in the 
Project Browser has changed to the new name. 

10. Next, to rename the Level 4 level view, select it from the drawing area; the properties of 
the selected level are displayed in the Properties palette.

11. Repeat steps 7 to 9 and rename Level 4 to Roof.

12. Press ESC to exit from the tool.

13. Move the cursor to the Project Browser and choose the Level 1 - Analytical option from 
the Structural Plans subhead.

Note
The Structural Plans head is a subhead in the Structural head of the Views (Discipline) 
hierarchy in the Project Browser. 

14. Right-click and then choose Delete from the displayed shortcut menu; the selected view 
name is deleted from the Project Browser.

15. Repeat steps 13 and 14 to delete the Level 2- Analytical option from the Structural 
Plans head.

Adding Grid Lines
In this section, you will add grids to the structural project. To add grids, you need to change 
the current view to the Entry level structural plan and then use the Grid tool.

Figure 3-43  Specifying the distance of the 
new level line

Figure 3-44  Creating the new level line 
using the alignment line
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 1.   Double-click on Entry from the Structural Plans head in the Project Browser; the Entry  
structural plan view will be displayed in the drawing area.

2.  Invoke the Grid tool from the Datum panel of the Structure tab; the Modify | Place Grid 
tab is displayed. 

3. In this tab, ensure that the Line tool is invoked from the Draw panel. Next, move the 
cursor toward the lower left corner of the drawing area and then click to specify the start 
point of the fi rst grid line; a grid line with temporary dimensions for angle emerges, refer 
to Figure 3-45 for location. 

4.  Move the cursor vertically up (at an angle of 90˚ from the horizontal plane) and click 
when it reaches near the North elevation arrow, refer to Figure 3-46 for location.

5. Now, move the cursor downward and position it near the right side of the endpoint of the 
grid line created previously, as shown in Figure 3-47.

Figure 3-45  Specifying the start point of the 
fi rst grid line

Figure 3-46  Specifying the endpoint of the 
fi rst grid line

Figure 3-47  Specifying the start point of the second vertical grid line
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6. As you place the temporary dimension near the endpoint, a temporary dimension 
appears with an extension line and the Extension snap. Type 10’ and press ENTER; the 
second grid line starts at a distance of 10’ from the start point of the fi rst grid line.

7. Move the cursor vertically up and place it near the bubble of the fi rst grid line.

8.  Click when the Vertical and Extension snap is displayed; the second grid line is 
created.

9. Repeat steps 5 to 8 to create fi ve more vertical grids with the distance specifi ed in 
Figure 3-48.

10. After creating all the vertical grids, press ESC twice to exit the Grid tool.

11. To rename grids, select the vertical grid line marked 4. Now, place the cursor over the text 
in the grid bubble of the selected grid line and click; an edit box is displayed, as shown 
in Figure 3-49.

12. Enter 3.1 in the edit box and press ENTER; the selected grid line is renamed.

Figure 3-48  Distance between the vertical grid lines 

Figure  3-49  Renaming the grid line using the edit box 
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Note
While renumbering the grid line, you can use the Zoom in Region and Zoom Out(2x) tools 
to view the grid numbers easily.

13. Without exiting the editing mode, select the next grid marked 5 and then move the cursor 
over its grid bubble and click to display the edit box. 

14. Enter 4 in the edit box and press ENTER to rename the selected line.

15. Repeat steps 11 and 12 to rename the grid lines marked 6 and 7 to 5 and 5.1, respectively, 
as shown in Figure 3-50.

16. After renumbering all the required vertical grids displayed in the drawing, press ESC to 
exit the editing mode. 

      
17. To add the horizontal grids, invoke the Grid tool from the Datum panel of the Structure 

tab.

18.  Next, move the cursor toward the top right of the vertical grid line marked 5.1 and click 
at the location shown in Figure 3-51.

Figure  3-50  The display of vertical grids after 
they are renumbered

Figure  3-51  The location of the start point of the fi rst horizontal grid 
line
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19. Move the cursor horizontally toward the left until it has crossed the vertical grid line 
marked 1. Click in the drawing area to create the fi rst horizontal grid line, as shown in 
Figure 3-52.

20. Move the cursor below the grid line alignment control of the start point of the fi rst 
horizontal grid line (grid line created previously); an alignment line with a temporary 
dimension is displayed.

21. Type 8’; an edit box is displayed with the entered value. Press ENTER; the second horizontal 
grid line will start below the start point of the fi rst horizontal grid line at a distance of 8’ 
from it.

22. Move the cursor horizontally toward the left and place it below the grid bubble (marked 
5.2) of the fi rst horizontal grid line, when the alignment line appears. 

23. Click when the Horizontal and Extension snap appears; the second horizontal grid line 
is created.

24. Repeat steps 20 to 23 to create the rest of horizontal grid lines and rename them, refer 
to Figures 3-53 and 3-54.

Note
To create the remaining horizontal grids from grid B to grid I refer to Figures 3-53 and 3-54. 
Note that both these fi gures are part of a single grid plan view. Figure 3-54 is the continuation 
of Figure 3-53 and is displayed separately to show the grid dimensions clearly. Further, the 
horizontal grids will be renamed using the same method used for vertical grids. 

Saving the Project
In this section, you will save the project fi le by using the Save As tool.

1. To save the project, choose the Save As > Project option from the Application Menu. 
On doing so, the Save As dialog box is displayed. 

2. In this dialog box, browse to the C/revit_structure_2013 location and create a folder with 
name c03. Now, open the c03 folder and enter c03_Commercial-Complex_tut1 in the 
File name edit box.

Figure  3-52  The location of the start point and endpoint of the fi rst horizontal grid line
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3. Choose the Save button; the Save As dialog box closes and the project fi le is saved.

Closing the Project
1. To close the project, choose the Close option from the Application Menu. 
 
 The fi le is closed and this completes Tutorial 1 of Chapter 3.

Tutorial 2              Industrial Complex
In this tutorial, you will create various project settings such as project information, project 
location, and browser organization for the project created in the Tutorial 2 of Chapter 2. Further, 
you will add levels and grids to the project fi le. Use the following project specifi cations:
              (Expected time: 1 hr 15 min)

Figure  3-53  The horizontal grid lines to be created with the specifi ed names and distances

Figure  3-54  The remaining horizontal grid lines in continuation of Figure 3-53
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1.  Rename Level 1 and Level 2 as Foundation Level and Entry, respectively.

2. Specify the elevation of Foundation Level and Entry levels as -6’ 0” and 0’ 
0”, respectively.

3. Levels to be added: Second Floor - Elevation 10’ 0”
    Roof - Elevation 24’ 0” 
    
4. File name to be assigned: c03_Industrial-Complex_tut2.rvt.

 The following steps are required to complete this tutorial:

a.   Open the Tutorial 2 of Chapter 2. 
b. Set project information and project location.
c. Modify existing levels and add new levels.
d. Add grid lines.
e. Resizing and renaming the grid lines.  
f. Save the project using the Save As tool.
g. Close the project by using the Close tool.

Opening the Existing Project 
In this section, you will open the project fi le created in the Tutorial 1 of Chapter 2.

1. To open the project fi le, choose Open > Project from the Application Menu; the Open 
dialog box is displayed.

2.  In this dialog box, browse to C:/revit_structure_2013/c02 folder and then choose the 
c02_Industrial-Complex_tut2.rvt project file. You can also download this file from 
http://www.cadcim.com. The path to download this fi le is as follows: Textbooks > Civil/GIS 
> Revit Structure > Exploring Autodesk Revit Structure 2013.

3.  Choose the Open button from the Open dialog box; the selected project fi le opens in the 
drawing window.

Setting the Project Information
In this section, you will add the project information to the industrial complex project fi le. 

1. To set the project information, choose the Project Information tool from the Settings 
panel of the Manage tab; the Project Properties dialog box is displayed.

2.   In the Project Properties dialog box, specify the project parameters as follows:
 
 Parameter     Value
     
 Project Issue Date    02/25/2013
 
 Project Status     Started
 
 Client Name    CADCIM Technologies

 Project Address    525, Andrews Drive Schereville 
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 Project Name    Industrial Complex
 
 Project Number    CIT/02/13

3. Choose the OK button; the Project  Properties dialog box closes and the project parameter 
is saved in the Project fi le.

4. Next, create an additional instance parameter for the project information. To do so, 
choose the Project Parameters tool from the Settings panel in the Manage tab; the Project 
Parameters dialog box is displayed.

5. Choose the Add button from the dialog box; the Parameter Properties dialog box is 
displayed.

6. In this dialog box, scroll the list in the Categories area and then select the Project 
Information check box.

7. In the Parameter Data area of the Parameter Properties dialog box, enter Project Manager in 
the Name edit box.

8.   Next, in the same area, ensure that the Instance radio button is selected and then ensure 
that the Common option is selected in the Discipline drop-down list.

9. Select the Text and Other options from the Type of Parameter and Group 
parameter under drop-down lists, respectively.

10. Next, choose the OK button from the Parameter Properties dialog box; the Project 
Parameters dialog box is displayed.

11. Choose the OK button from the Project Parameter dialog box; the dialog box closes.

12. To enter the value for the new parameter, choose the Project Information tool from the 
Settings panel of the Manage tab; the Project Properties dialog box is displayed.

13. In this dialog box, click in the Value fi eld corresponding to the Project Manager 
parameter and enter Sham Tickoo.

14. Now, choose the OK button; the Project Properties dialog box closes and the value for 

the newly added parameter is saved in the project fi le.

Setting the Project Location
In this section, you will specify the geographical location of the project.

1. To specify the geographical location of the project, choose the Location tool from the 
Project Location panel of the Manage tab; the Location Weather and Site dialog box is 
displayed. 

2. Ensure that the Location tab is chosen in this dialog box. Then, select the Internet 
Mapping Service option from the Defi ne Location by drop-down list. 
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Note
While selecting the Internet Mapping Service option from the Defi ne Location by drop-down 
list, ensure that the internet is connected to your system. If the internet is not connected, a message 
box will be displayed below the Project Address edit box, informing that the connection could 
not be established to the Internet Mapping Service.  

3. In the Project Address edit box, delete the default text, and enter Indianapolis, and then 
choose the Search button; the desired location is displayed on the map in the area below 
the edit box. Note that the search uses the Google Map service to display the location, 
refer to Figure 3-55.   

4. Next, choose the Site tab from the Location Weather and Site dialog box and then choose 
the Duplicate button; the Name dialog box is displayed.

5. Enter CADCIM-IN in the Name edit box and then choose the OK button; the Name 
dialog box closes and the name entered is displayed and highlighted in the Sites defi ned 
in this project list box.

6. Now, choose the Make Current button and then choose the OK button; the Location 
Weather and Site dialog box closes and the settings for the project location are saved in 
the project fi le.

Modifying the Existing Levels
In this section, you will modify the existing levels in the project fi le. To do so, you need to 
select an elevation view from the Project Browser and then use the Level tool.

Figure  3-55  The desired location displayed in the Location 
Weather and Site dialog box
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1.  Before modifying levels, move the cursor to the Project Browser and then double-click on 
the South option displayed under the Elevation (Building Elevation) head; the current 
view is changed to the South elevation view.

Note
In the South elevation view, make sure that the Hidden Line option is chosen for the visual 
graphics style in the View Control Bar. 

2.  Next, zoom into the drawing area so that the texts on the level lines are visible. Click on 
the Level 1 level line and move the cursor over the text Level 1; the text is highlighted. 

3. Again, click on the text; an edit box is displayed.

4.  Enter Foundation Level in the edit box and press ENTER; the Revit message box is 
displayed, prompting you to confi rm whether or not to rename the corresponding view 
of the selected level. 

5. In the Revit message box, choose the Yes button; the name of the level is changed. Also, 
notice that the name of the view corresponding to the level changes in the Structural 
Plans head of Project Browser.

6.  Next, move the cursor over the elevation value of the Foundation Level level; the 
elevation value gets highlighted.

7. Click on the highlighted elevation value; an edit box is displayed.

8. Enter -6’ 0” in the edit box and press ENTER. Next, press ESC to exit from 
the modifi cation.

9.  Repeat steps 2 to 8 to rename Level 2 level to Entry and modify the elevation of it to  
0’0”, respectively.

10.  Next, right-click in the drawing area; a shortcut menu is displayed.
 
11. Choose the Zoom to Fit option from the shortcut menu; the extent of level lines are 

displayed in the drawing area.

12.  Next, select the Foundation Level level line and place the cursor over the grid length 
control displayed on the left.

13. Press and hold the left mouse button and drag the mouse to the right; the level lines move 
along the cursor.

14. Click in the drawing area when the length of the level line reduces to almost half of its 
existing length

15. Next, press ESC to exit from the edit controls. 

16. Right-click in the drawing area and then choose Zoom to Fit from the shortcut menu 
displayed; the current view fi ts the extent of the length of the level lines.
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Adding New Levels
In this section, you will add two levels to the project fi le using the Level tool.

1. To add a new level, invoke the Level tool from the Datum panel of the Structure tab.

2. To create a nonstory level, clear the Make Plan View check box in the Options Bar.

3.  Now, move the cursor near the left endpoint of the Foundation Level level line, and when 
the alignment line appears, enter 6”.

4. Press ENTER and move the cursor toward the right until the alignment line appears 
above and across the Foundation Level level bubble. Next, click to complete the level 
line. The new level line is created. It displays the level name as Level 3 and the elevation 
as -5’ - 6”.

5. Without exiting the Level tool, select the Make Plan View check box in the Options 
Bar.

6.  Move the cursor near and above the left endpoint of the Entry level line and when the 
alignment line appears, enter 10’. Next, press ENTER.

7. Move the cursor toward the right till the alignment line appears above the Entry level 
bubble, and click to complete the level line. The new level line is created. It displays the 
level name as Level 4 and the elevation as 10’ - 0”.

8. Repeat steps 6 and 7 to create a level line with the default name Level 5 at a distance of 
14’ from Level 4. Note that the elevation of the Level 5 level line is displayed as 24’ 0”.

9.  Next, press ESC twice to exit from the Level tool.
 
10. Select the Level 3 level line; the properties of the selected level line are displayed in the 

Properties palette.

11.  In the Properties palette, click in the value fi eld corresponding to the Name parameter 
and replace the existing name Level 3 with T.O.F.

12.  Choose the Apply button in the palette; the name of the level line changes in the project 
view. 

13. To rename the Level 4 level, select it from the drawing area; the properties of the selected 
level are displayed in the Properties palette.

14. In the Properties palette, click in the value fi eld corresponding to the Name parameter 
and replace the existing name Level 4 with Second Floor.

15.  Choose the Apply button in the palette; the Revit message box is displayed.

16. Choose the Yes button from the message box; the Revit message box closes. Notice 
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that the name of the selected level line as well as its corresponding view name has been 
changed.

17. Repeat steps 13 to 16 and rename the Level 5 to Roof.

18. Press ESC to exit the Level tool.

19. Now, move the cursor to the Project Browser and choose the Level 1 - Analytical option 
from the Structural Plans head.

20. Right-click and then choose Delete from the shortcut menu; the name of the selected view 
is deleted from the Project Browser.

21. Repeat steps 19 and 20 to delete the Level 2- Analytical option from the Structural 
Plans head.

Adding Grid Lines
In this section, you will add grids to the project using the Grid tool.

1.  To add grids, change the current view to the Entry structural plan view. To do so, 
double-click on Entry from the Structural Plans head in the Project Browser; the Entry 
structural plan view is displayed in the drawing area.

2.  Invoke the Grid tool from the Datum panel of the Structure tab; the Modify| Place Grid 
tab is displayed. 

3. Ensure that the Line tool is invoked from the list box in the Draw panel of this tab. 
Then, move the cursor toward the lower left corner of the drawing area (near the South 
elevation arrow) and click, as shown in Figure 3-56.

4.  On clicking, a grid line emerges. Move the cursor horizontally to the right and click when 
it reaches at a point below the East elevation arrow; refer to Figure 3-57 for location.

5. Next, right-click in the drawing area; a shortcut menu is displayed. Choose Snap Overrides > 
Endpoints from the shortcut menu.

Figure  3-56  The location for the start point of the fi rst horizontal grid line
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6. Move the cursor near the left endpoint of the fi rst grid (grid created earlier) and place the 
cursor on it until it (the fi rst grid line) is highlighted and the Endpoint snap appears. 

7. Next, click as the Endpoint snap appears and the fi rst grid line is highlighted; a grid line 
appears that displays the temporary dimension of its angle measured from the horizontal 
axis.

8. Next, move the cursor toward the right and above the grid bubble of the grid line 
created earlier. 

9.  Click when the temporary angular dimension displays 15.00° and an alignment line 
appears from the endpoint of the previous grid line, refer to Figure 3-58.

10. Repeat steps 5 to 9 to create the remaining fi ve grid lines that emerge from the start point 
of the fi rst grid line. The temporary dimensions that you will consider to create the fi ve 
radial grids are : 30°, 45°, 60°, 75°, and 90°, refer to Figure 3-59.

Figure 3-57  The location for the endpoint of the 
fi rst horizontal grid line

Figure  3-58  The grid line displaying the angular dimension 
and an alignment line
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Note
While creating these grids everytime, you need to use the Endpoints snap override option and 
align the endpoint of each grid to the endpoint of the grid created earlier.

11.  Press ESC twice to exit the Grid tool.

12. Right-click in the drawing area and then choose Zoom to Fit from the shortcut menu.

13. Now, invoke the Grid tool from the Datum panel of the Structure tab.

14. Choose the Center-ends Arc tool from the list box in the Draw panel of the Modify |Place 
Grid tab.

15. Now move the cursor toward the start point of the fi rst grid line and click when the 
Endpoint snap appears; a circle appears with temporary dimensions denoting its radius 
and the start angle of the arc with the fi rst grid line.

16.  Move the cursor vertically upward along the last grid line created (the vertical grid 
line).

17.  When the linear temporary dimension displays 36’ and the angular temporary dimension 
displays 90°, enter 30’ and press ENTER; a curved arc emerges and starts from a distance 
of 30’ from the start point of the fi rst grid line.

18.  Move the cursor clockwise until it has been placed below the fi rst grid line and click when 
the fi rst alignment line with the Extension snap emerges from the start point of the fi rst 
grid line.  

19. Now repeat steps 15 to 18 to create a curved grid line with a radial distance of 50’ from 
the start point of the fi rst grid, refer to Figure 3-60.

20. Next, press ESC to exit from the Grid tool.

Figure  3-59  The radial grid lines with varying angles
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21. To complete the grid pattern for the project, invoke the Grid tool and use the Line tool 

from the list box in the Draw panel of the Modify |Place Grid tab; the remaining grids 
are created with the specifi ed distance, as shown in Figure 3-61.  

Resizing the Grid Lines 
In this section, you will resize the grids using the drag controls.

1.  To start resizing, select the fi rst grid line of the project and then move the cursor towards 
its endpoint near the grid bubble, as shown in Figure 3-62.

2. Now, press and drag the cursor toward the left and release the mouse when the cursor 
along with the grid endpoint reaches the location shown in Figure 3-63.  

3. Press ESC to exit from the editing mode. 

4.  Select the other grids individually and repeat steps 1 to 4 to resize all the grids in the 
project view.

Note
While resizing the grids, you can align them in reference to their previous grids with the help 
of the alignment control.                 

Figure  3-60  The curved grid lines created 

Figure  3-61  The dimensions of the remaining grid lines
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Renaming Grids 
In this section, you will rename all grids created in the previous section.   

1. To rename grids, select the curved grid, as shown in Figure 3-64.

2. Move the cursor over the grid bubble of the selected grid and click; an edit box is 
displayed. Enter A’ in the displayed edit box and press ENTER. The selected curved grid 
is renamed.

3. Press ESC to exit the editing mode.

4.   To rename all grids in the project, select them individually and repeat steps 2 and 3. Refer 
to Figure 3-65 for new names of the grids.   

Saving the Project
 In this section, you will save the project fi le using the Save As tool.

Figure  3-62  Moving the cursor toward the endpoint

Figure  3-63  Dragging the grid endpoint to resize Figure  3-64  Selecting the curved line 
to rename 
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1. Choose Save  As > Project option from the Application Menu; the Save As dialog box 
is displayed. 

2. In this dialog box, browse to the C:/revit_structure_2013/c03 location and enter 
c03_Industrial-Complex_tut2 in the File name edit box.

3. Now, choose the Save button; the Save As dialog box closes and the project fi le is 
saved.

Closing the Project
1. Choose the Close option from Application Menu. 
 
 The fi le is closed and this completes Tutorial 2 of Chapter 3. 

Answer the following questions and then compare them to those given at the end of this 
chapter:

1. _________________ is the default template fi le in Autodesk Revit Structure 2013. 

2. To defi ne the geographical location of a project, you need to invoke the _____________ 
tool from the Manage tab.

3. To transfer project standards from the source fi le to the target fi le, you need to invoke the 
__________________tool from the Manage tab.

Figure  3-65  The grid lines with new names 

Self-Evaluation Test
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4. You can use the _____________________tool to manage the Project Browser.

5. In a grid line, you can create a gap between two end segments by setting the______________ 
parameter in the Type Properties dialog box to None.

6. You can use the __________________ option in the Options Bar to create a grid line that 
starts at a specifi ed offset distance from a point defi ned in the drawing area.

7. ______________________can be used as datum planes to act as a guideline for creating 
elements.

8. The visibility of a work plane grid can be controlled by using the ____________tool from 
the Work Plane panel of the Structure tab. 

9. In Revit Structure, you can include project information to the schedules of linked models. 
(T/F)

10. The visibility of level bubble on either sides of a level line cannot be controlled. (T/F)

11. To add the name of the author in a  project, you need to invoke the _________ tool from the 
      Manage tab.

Answer the following questions:

1. The visibility of datum elements can be controlled by using the______________   
tool.

2. The Project Browser displays the _______________folder, which contains the 
element families loaded into the project fi le.

3. To create browser organization for sheets, choose the ___________________tab from the 
Browser Organization dialog box.

4. To add levels to a project view, you need to invoke the Level tool from the _______________
panel in the Structure tab.

5. You can use the _____________________tool to create curved grids.

6. To make a hidden level line visible, choose ___________________from the Status Bar. 

7. A _______________level does not hold any plan view but acts as a host for placing objects 
and information.

8. You can clear the ______________________check box in the Options Bar of the Modify 
| Place Level tab to create a nonstory level.

Review Questions
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9.  You cannot copy project standards from a project to the current project. (T/F)

10. A work plane can be horizontal, vertical, or inclined at any specifi ed angle. (T/F)

Exercise 1                          Academic Institution
Exercises

In this exercise, you will create project information for the project created in the Exercise 1 of 
Chapter 2. Further, you will also add levels and grids to the project fi le. Refer to Figure 3-66 
for grid dimensions and names. Use the following project specifi cations:         
              (Expected time: 1 hr 15 min)
1. Project fi le to be used: c02_Academic-Institution_exer1.rvt. 
2. Rename Level 1 and Level 2 as Foundation Level and Entry, respectively.
3. Specify the elevation of Foundation Level and Entry levels as -5’6” 0” and 0’ 

0”, respectively.
4. Story levels to be added: Second Floor - Elevation 12’ 6”
            Roof - Elevation 25’ 0” 
5. Nonstory level to be added: T.O.F- Elevation -5’
6. Project information to be added:
 Project Issue Date    03/04/2013 
 Project Status     Started 
 Client Name    CADCIM Technologies
 Project Address    525, Andrews Drive Schereville 
 Project Name    Academic Institution
 Project Number    AI/03/13

7. Grids to be added in the Entry project view using the dimensions and names as shown in 
Figure 3-66.

8. File name to be assigned: c03_Academic-Institution_exer1.rvt.

Exercise 2                                             Factory Shed

In this exercise, you will add levels and grids to the project fi le created in Exercise 2 of 
Chapter 2. Refer to Figure 3-67 for grid dimensions and names. Use the following project 
specifi cations:                                
                                                                                                  (Expected time: 1 hr 15 min)
1. Project fi le to be used: c02_Factory-Shed_exer2.rvt. 
2. Rename Level 1 and Level 2 as Below Ground and Plinth, respectively.
3. Specify the elevation of Below Ground and Plinth levels as -2’0” and 1’0”, respectively.
4. Story levels to be added: Second Floor - Elevation 14’
            Roof - Elevation 24’ 0” 
5. Grids to be added in the Plinth project view using dimensions and names, as shown in 

Figure 3-67.
6. File name to be assigned: c03_Factory-Shed_exer2.rvt.
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Figure  3-66 The grid lines with new names for the Academic 
Institution structure

Figure  3-67  The grid lines with new names for the Factory 
Shed structure
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Download the c03_Residential_Build_exer3  fi le from http://www.cadcim.com. The path of the fi le 
is as follows: Textbooks > Civil/GIS > Revit Structure > Exploring Autodesk Revit Structure 2013. 
                                                                                           
 In this exercise open the c03_Residential_Build_exer3 fi le and add levels and grids to it. Refer 
to Figures 3-68, 3-69, and 3-70. Further, you will add project information to the project. Use 
the following specifi cations to complete the exercise:
                                                                                                           (Expected time: 45 min)
1. Rename Level 1 and Level 2 as Subgrade and GL, respectively.
2. Specify the elevation of Subgrade and GL levels as -4’6” 0” and 0’ 0”, respectively. 
3. Story levels to be added: FL- Elevation 11’0”
           TL- Elevation 19’-6”
4. Nonstory level to be added: T.O.F- Elevation -4’
5. Project information to be added:
 Project Issue Date    05/09/2013 
 Project Status     Started 
 Client Name    CADCIM Technologies
 Structural Consultant   CADCIM-Structural Engineers 
 Mechanical Consultant   Sham Tickoo
 Quantity Surveyors    CADCIM-Quantity Surveyors
  Project Name    Residential Building
 Documented Contract 
 Commencement Date   20/09/2013
 Documented Contract Completion Date 31/07/2014
 Provisional Period Allowed in Contract 30 Days
 Gross Area of the Project   1200 sq. ft.

6. File name to be assigned: c03_Residential_Build_exer3_fi nal. 

Exercise 3                                          Residential Building

Figure  3-68  Elevation of the project displaying the name of 
the levels and their respective elevations
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Answers to Self-Evaluation Test
1. Structural Analysis-Default, 2. Location, 3. Transfer Project Standards, 4. Browser 
Organization, 5. Center Segment 6. Offset, 7. Reference Planes, 8. Show, 9. T, 10. F, 11. 
Project Parameter

Figure  3-69  The grid lines with the specifi ed names and 
distances

Figure  3-70  The remaining grid lines in continuation of Figure 3-69


